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Login to WS for the first time
When the application is install properly (see section Installing WS to install application). A short cut will be install on the desktop of the computer. 

[image: C:\Users\pmiranda\Pictures\WS_Logo.JPG]

Double click on the icon and a window will appear. 
[image: ]
The window will ask for user name and password. The administrator will create the log for the personal to use the application.  The default Use Name is Administrator and the password is ABC.  It is recommended to create Staff for login and not share the same login.





[bookmark: _Toc319325086][bookmark: _Toc402513096]Navigating WS
Navigating through WS can be done using the Navigation Button located in the top left corner of the main window. Clicking on this button will show a navigation menu with multiple Navigation Items.
1. Click the Navigation Button
[image: ]

2. Locate desired section and click
[image: ]  


[bookmark: _Toc402513097]The Items on this Navigation Menu include
· Client
· Client Only
· Children Only
· Alleged Abusers Only
· Call
· Scheduler
· Report
· Other	
· Task
· Staff
· Field Set
· Survey
· My Details

When clicking on a navigation item, the view for that item will normally appear as a tab. The tabs make it easy to navigate back and forth between modules. If a tab is already open, clicking on the respective item in the Navigation Menu will cause the existing tab to appear.


[bookmark: _Toc402513098]Ribbon in WS
Welcome to WS application.  The Ribbon is intended to find the commands and tools that you need to work in WS. 
[image: C:\Users\pmiranda\Pictures\WS_1.jpg]


[bookmark: _Toc402513099]Home. 

The tab Home is where you can create, save, delete, and filter. Home tab has a division of tools, image below. The ribbon is mark with 1 to 8 to specify the functionality of each one.
[image: C:\Users\pmiranda\Pictures\WS_3.jpg]
Number 1 is NEW where user can create clients, calls, surveys and tasks. 
[image: C:\Users\pmiranda\Pictures\WS_2.jpg]
Number 2 is SAVE. Save has two options, save and save and close. The difference between save and save and close, is when you click on save and close it will save your work and close the current window. 
[image: C:\Users\pmiranda\Pictures\WS_4.jpg]
Number 3 is Edit. Edit has two options, one is to delete and cancel. Delete will erase the record from the application. Cancel will not save changes in the fields. Cancel will not work when you delete records by mistake.  
Number 4 is View. View has two options, Shelter Stats and Refresh. 
Number 5 is Close this will close the current tab that is open, if information in unsaved, WS will ask the user if they would like to Save, in most cases, Yes is desired.
Number 6 is Navigating up or down in the list of Objects.  In this example, a Person is open, clicking Next will show the Next Person in the List of Persons.
Number 7 and 8, these area is discussed in greater details in the section Filtering in a List View.

[bookmark: _Toc402513100]Clients
1. Click the Navigation Button. Choose the appropriate client to fill the information. [image: C:\Users\pmiranda\Pictures\WS_NC3.jpg]


[bookmark: _Toc402513101]North Carolina Screen shots and Details
List of People (Clients, Children Alleged Abusers)
[image: ] 


[bookmark: _Toc402513102]Client Detail View
Opening a Client from the Person list will result in the details below:
[image: ]


[bookmark: _Toc402513103]Child Detail View
Opening a Child from the Person list will result in the details below:
[image: ]


[bookmark: _Toc402513104]Alleged Abuser Detail View
Opening an Alleged Abuser from the Person list will result in the details below:
[image: ]


[bookmark: _Toc402513105]Tabs within a Client, Child or Alleged Abuser
Clients can have various historical information or additional details, these tabs include:
· Activity Sessions
· Progress Notes
· Children/Dependents
· Offenders
· Resources
· Health Information
· Emergency Contact
· Incidents
· Legal
· Stays
· Waiting List
· Surveys
· File Attachments
· Education
[image: ]
[image: ]
Tab layout is horizontal, depending on the screen resolution, scrolling might be needed (example above).


[bookmark: _Toc402513106]Activity Sessions
Activity Sessions are the Services that are provided to the Client or Child.  Important fields on Activity Sessions:
· Service Code is the Service that is being provided to the Client
· Program Type
· Start On, Start Time and Duration
· In Person
· Location
· Person tab, this is the list of Clients and/or Children associated to the Service.  Using multiple Clients can be for Group Services or ease of data entry
· Staff tab, include all the Staff needing to be associated to this Service
[image: ]

[bookmark: _Toc402513107]Progress Notes
Progress Notes is a general area to store information about the Client or Child with a Date Created and options Counselor.
[image: ]


[bookmark: _Toc402513108]Children/Dependents
A list of Children can be collected for the Client.  This is known as the associated Client, Parent or Guardian from the Child Detail View.  When double-clicking on a Child, the Child Detail View will open.
[image: ]


[bookmark: _Toc402513109]Offenders
Similar to the Children tab, this is a list of all the Offenders (Alleged Abusers) associated to this Client.
[image: ]
Clicking the Add will open a List to Search for Alleged Abusers, if the Abuser is not in the database, clicking New will allow the creation of a new Alleged Abuser.  Highlighting the Alleged Abuser (new or recently created) and clicking OK will add to the list of Offenders
[image: ]


[bookmark: _Toc402513110]Resources
Resources tab is used for documenting the Family Income and Income Sources (at Entry / Exit).
[image: ]


[bookmark: _Toc402513111]Health Information
Health Information has the following details
· Substance Abuse Note
· Medications
· Previous Substance Abuse
· Current Substance Abuse
· Pregnant
· Medical/Mental Health Conditions
· Health Providers
· Disability
· Disability Accommodation
[image: ]


[bookmark: _Toc402513112]Emergency Contact
Each Client has the ability to provide a Contact in the event of an Emergency
[image: ]


[bookmark: _Toc402513113]Incidents
Incidents are crucial for reporting when looking for specific types of Victimization.  
Import fields:
· Incident Date
· Incident Type 
An example of importance; CFW reports Type of Assault > Marital Rape (see page 16 [as of Oct 2014] of CFW Reporting guide).
[image: ]



[bookmark: _Toc402513114]Legal
Legal has two options when creating the information; Criminal and Civil (non PO) and Protective Orders
[image: ]


Legal > Criminal and Civil (non PO)
[image: ]
Legal > Protective Orders
[image: ]
[bookmark: _Toc402513115]Stays
[image: ]


[bookmark: _Toc402513116]Waiting List
[image: ]


[bookmark: _Toc402513117]Surveys
Surveys are used to collect additional information regarding the Client, the FVP Outcomes survey was created and included in the default install of WS for North Carolina.
Example Survey (FVP Outcomes):
[image: ]


[bookmark: _Toc402513118]File Attachments
File Attachments can be associated to the Client, Child or Alleged Abuser.  Use this when documents, signatures or important details are required to be saved on the Client’s file.
[image: ]
Attaching a File
1. Click on the Click here to add new row, this will enable the … icon at the end of the Attachment column
[image: ]
2. This will open a dialog box that will allow the user to located the file, then click Open to add to the File Attachment record:
[image: ]


[bookmark: _Toc402513119]Education
[image: ]

[bookmark: _Toc402513120]Schools
Schools is a tab that is only available for Children
[image: ]


[bookmark: _Toc402513121]Cases
Cases are only available for Alleged Abusers, this is related to Legal > Criminal an Civil (non PO)
[image: ]

[bookmark: _Toc402513122]Substance/Mental Health
Substance/Mental Health is available for the Alleged Abuser
[image: ]


[bookmark: _Toc402513123]Physical Description
Physical Description is only available for the Alleged Abuser
[image: ]



[bookmark: _Toc402513124]Vehicle
[image: ]


[bookmark: _Toc402513125]Using Activity Sessions

[bookmark: _Toc402513126]What is an Activity Session
An Activity Session is a Date and Time based record for the Person (Client, Child and/or Alleged Abuser), sometime referred as a Service.  Each Activity Session can be associated to zero, one or many Persons, as well as zero, one or many Staff Members.
Reporting on Activity Sessions, most reporting for Activity Sessions is based on the Person(s) that are associated to the Activity Session, for example, if an Activity Session has no Persons associated and the Person Activity Report was executed, there wouldn’t be any data.  However, if an Activity Session was created and adding in at least one Person, the report will produce results (ie: 1 Person and 1 Session).  Please note this detail for data entry and reporting options.
[bookmark: _Toc402513127]How to create an Activity Session
There are two ways to create an Activity Session; In the Client/Child/Alleged Abuser Detail View or in the Scheduler.


[bookmark: _Toc402513128]Creating an Activity Session in a Detail View

1. Create a new Client/Child/Alleged Abuser  or open an existing Person to its Detail View
2. Locate Activity Session tab (or Customize Activity Sessions if List View isn’t available)
[image: ]

3. Click New, this will open a Person Activity with the existing (or new) Person
[image: ]
Note that in the Person tab, “Client, Testing”  is automatically added

4. To add additional Persons; 
a. On the Person tab, click on click here to add new row
[image: ]

b. In the Generic Person Column search and select the desired Person
[image: ]

c. Repeat as need
5. Input the remaining information (ie: Staff, Session Type, Start On, Duration, etc)
6. Save and Close Person Activity
7. Save Client/Child/Alleged Abuser


[bookmark: _Toc402513129]Creating an Activity Session from the Scheduler

1. Open the Scheduler
[image: ]

2. Navigate to the desired Date and Time through the Calendar
[image: ]
3. Click and drag the mouse on the Start Time within the Scheduler to the End Time of the Activity Session
[image: ]

4. Right click on the newly highlighted area, hover over Activity then click Session
[image: ]

5. Now an Activity Session is open
Note that there is no Persons in the Person tab
[image: ]

6. To add additional Persons; 
a. On the Person tab, click on click here to add new row
[image: ]

b. In the Generic Person Column search and select the desired Person
[image: ]

c. Repeat as need
7. Input the remaining information (ie: Staff, Session Type, Start On, Duration, etc)
Note that there is already a Staff member in the Staff tab, this automatically added the Staff to the list because the Activity Session was added under that Staff members Schedule
8. Save and Close the Activity Session


[bookmark: _Toc402513130]Using Administrative Time

[bookmark: _Toc402513131]What is an Administrative Time
An Administrative Time is a Date and Time based record for the Staff.  Each Administrative Time can be associated to zero, one or many Staff Members.  However, it is not advised to have zero Staff Members on an Administrative Time.
[bookmark: _Toc402513132]How to create an Administrative Time
To create an Administrative Time, the user will need to be in the Scheduler
1. Open the Scheduler
[image: ]

2. Navigate to the desired Date and Time through the Calendar
[image: ]
3. Click and drag the mouse on the Start Time within the Scheduler to the End Time of the Administrative Time
[image: ]

4. Right click on the newly highlighted area, hover over Activity then click Administrative Time
[image: ]

5. Now an Administrative Time is open
Note that there is a Staff Member in the Staff tab
[image: ]

6. To add additional Staff; 
a. On the Staff tab, click on Add
[image: ]

b. Select one or many of the existing Staff Members, the click Ok[image: ]

c. Repeat as need
7. Input the remaining information (ie: Administrative Type, Start On, Duration, etc)
8. Save and Close the Administrative Time


[bookmark: _Toc402513133]Using Non-Working Times

[bookmark: _Toc402513134]What is an Non-Working Time
A Non-Working Time is a Date and Time based record for the Staff, a simple example of Non-Working Time would be Vacation or Personal Days off.  Each Non-Working Time can be associated to zero, one or many Staff Members.  However, it is not advised to have zero Staff Members on a Non-Working Time.
[bookmark: _Toc402513135]How to create an Non-Working Time
To create a Non-Working Time, the user will need to be in the Scheduler
1. Open the Scheduler
[image: ]

2. Navigate to the desired Date and Time through the Calendar
[image: ]
3. Click and drag the mouse on the Start Time within the Scheduler to the End Time of the Non-Working Time
[image: ]

4. Right click on the newly highlighted area, hover over Activity then click Non-Working Time
[image: ]

5. Now an Non-Working Time is open
Note that there is a Staff Member in the Staff tab
[image: ]

6. To add additional Staff; 
a. On the Staff tab, click on Add
[image: ]

b. Select one or many of the existing Staff Members, the click Ok[image: ]

c. Repeat as need
7. Input the remaining information (ie: Non-Working Time Type, Start On, Duration, etc)
8. Save and Close the Non-Working Time


[bookmark: _Toc402513136]Scheduler
The Scheduler is a MS Outlook style Calendar for the software, Activities such as Activity Session, Administrative Time and Non-Working Time can be created within this view.
[bookmark: _Toc402513137]What’s in the Ribbon
Manage Resources
Managing Resources from the Scheduler, to access the list of Staff Members, click Manage Resources
[image: ]
Manage Resources List View
[image: ]
Each Staff Member has a checkbox Show In Scheduler, this will determine if that Staff Member will be visible in the list of Resources in the Scheduler
[image: ]
Group By
More information coming soon.
View Variant
In WS, there are two views to see the Scheduler, first option is the Scheduler as mentioned above, the second view is a Person Activity View call Worksheet, this will show a list of Person Activities and will NOT show Administrative Time, Non-Working Time or Activity Session with no Person associated.
[image: ]
Note when the View is changed from Schedule to Worksheet (or vice-versa), the software will remember the view the Staff was last using.  Changing back to Scheduler view is recommended for most Staff.
[bookmark: _Toc402513138]Scheduler
The Scheduler has many parts and options to customize the viewing experience and limit clutter as needed.
Time Increments
The Scheduler can display Activities by various time increments that can be changed by the Staff Member. 
Increments Area (highlighted in red)
[image: ]
Accessing the Increments
1. Right click on the Increments Area
2. Select an appropriate increment
[image: ]
3. The current increment will be displayed with a check mark to the left of the increment[image: ]


Resources
Resources are essentially Staff Member that have Show In Scheduler checked.  Each Resource has the ability to be temporarily hidden on the Scheduler; this allows quick viewing of one or two Staff Member, then returning to all Resource by simply clicking the check box
[image: ]
When there is one or more Resources checked, the selected dates will show that Resource’s Activities (Activity Session, Administrative Time, Non-Working Time).  In the screen shot above, we are viewing Administrator and Staff Member’s December 5th side-by-side.  Unchecking Staff Member will remove them from the Scheduler.
[image: ]

Calendar
The Calendar can be used for quick navigation to specific dates in the Scheduler.  As well as quickly navigate back to Today
	[image: ]
	[image: ]




Change Week
Allow the Staff Member to cycle through the weeks with the Change Week area
[image: ]
Viewing multiple non-sequential days together
To view multiple days in the Scheduler that are not sequential to each other
1. Click the first Day within the list of Days
[image: ]

2. Hold the CTRL button on the keyboard, then click the next day you wish to view, repeat as needed

Note, Staff are able to view day patterns and odd dates as needed, this may require a little practice if the next day in the list is not visible (ie: View January, but want to look at April)


[bookmark: _Toc402513139]Setup Agency-Shelter information
Accessing Program Options
To open the Program Options (or Show Options)
1. Login to WS
2. Click on the Tools tab
3. Click Show Options
[image: ]

4. On the Program Options tab, enter any of the required information, click Ok when ready to Save
[image: ]


[bookmark: _Toc402513140]Apply License File to database
Accessing Program Options
To open the Program Options (or Show Options)
1. Login to WS
2. Click on the Tools tab
3. Click Show Options
[image: ]

4. Open the License File tab
[image: ]



5. In most cases, the File Data will be blank/empty, copy and paste the provided license file text into the File Data, then ensure that the Created Date is today or a day in the past (never a future date).  Please remove all leading and trailing spaces of the license file. Click Ok when complete. If you do not have a License File, a request form can be filled out here (please remember to enclose all agency details to ensure that Osnium generates a License File correctly).

6. If there is an issue with the License File, please ensure that all the information is correct (no need to verify each number or character, etc) and that there are no leading or trailing spaces or you may receive this type of message:
[image: ]

Example of an issue with a License File; the blue highlighted are of “extra spaces” at the end of the License File.  Removing the spaced and clicking Ok resolved the issue
[image: ]


[bookmark: _Toc402513141]Setup Shelter Beds/Max Stays

Accessing Program Options
To open the Program Options (or Show Options)
1. Login to WS
2. Click on the Tools tab
3. Click Show Options
[image: ]

4. Click on the License File tab
5. Ensure that WS has a License File containing MAX STAYS including a value higher than 3
Proceed forward if MaxStays exists
6. Click on Program Options
7. Locate Max Stays field and enter the numeric value of the Maximum amount of beds that the Shelter can support (ie: 50 beds = 50, 100 rooms with 150 beds = 150 beds), click Ok when setup
[image: ]

8. Click on the Home tab
[image: ]

9. Click on Shelter Stats
[image: ]
Max Stays is now showing 50 because the Program Options were updated:
[image: ]



[bookmark: _Toc402513142]Exceeded Stay Limit Message

Software License has exceeded the limit of Stays
Typical message when there are too many Stays (with no Discharge Date), exceeding the Max Stays in Program Options
[image: ]
[bookmark: _Toc402513143]Checklist to ensure WS is setup properly

1. License File has been applied to Tools > Show/Program Options > License File
Furthermore, is there text within the License File text that says (X being the amount of bed the shelter supports):  key="MaxStays" value="X"
If no, please see Apply license file documentation

2. Max Stays in Tools > Show/Program Options is setup with the correct amount of Bed that are available.  Default value is 3, change this value to the maximum Beds in the shelter, this value should be equal or less than the value in #1 (ie: key="MaxStays" value="X").  

3. Check how many Active Stays are in the database.  Often, users of WS believe that they don’t have any additional active Stays, in most cases though, the information of the Stay is simply out of date (ie: Client has left the shelter, but Client profile hasn’t been updated yet).
To check Active Stays, please see List of Active Stays documentation.


[bookmark: _Toc402513144]Creating Staff/Users to login to WS

Navigating to Staff List View

1. Login to WS
2. Open the Main Menu
3. Hover the mouse over Other
4. Click to open Staff in a List View
[image: ]

5. List of all Staff
(please do not delete Anonymous, this is required for WS to get into the Login screen)
[image: ]
[bookmark: _Toc402513145]Creating a New Staff Member

1. Click New > Staff
[image: ]

2. Input First Name, Last Name and User Name (please note that User Name MUST be unique)
[image: ]



3. Assign at least one Role (ie: Administrators) by clicking on the Roles tab, then Add and finally selecting a specific Role
[image: ]

4. Click Ok to add the highlighted Role(s) to see them appear in the Roles list
[image: ]

[image: ]



5. Now that the new Staff has a UserName and at least one Role, a Password must be generated for the Staff member to login for the first time, click Reset Password, note the predefined password (or clear the existing password and enter a desired password) and click Reset Password
[image: ]
[image: ]



6. Now that the Reset Password has been performed, the software will automatically check Change Password On First Login, Save and Close to complete the new Staff Member, however, if this new Staff does not want to change password on first login (or the Administrator would like to keep a record of each password) then Osnium would suggest to uncheck Change Password On First Login allowing the Staff to simply login.
[image: ]

7. Note that this created a Staff member with the default Model File (customization look and feel).  Please see how to Pull or Push Model File if the first login of this Staff DOES NOT look like the Administrator Model File.

8. Additional fields can be used to manage successful login of individual Staff, these fields include:
· Is Active
· Account Locked



[bookmark: _Toc402513146]Importing a Model File

Obtaining Model File
Download the Model File onto the Desktop or Download folder, this file should be *.osm (osm meaning Osnium Model File).  This file is usually obtains via email.
Importing a Model File to the currently logged in Staff Member of WS

* Please note that importing a Model File will clear ALL previous customization changes, it is recommended to Export Model File as a backup before proceeding
5. Login to WS
6. Click on the Tools tab
1. Click on Edit Model File arrow, then Import Model File, from there locate the Download *.osm file and Open (this will import the model file to the current logged in Staff Member)
[image: ]
[image: ]

2. Click Ok to import, successful import message:
[image: ]

3. In order to see the changes, the Staff member will need to Log off or Exit the software, then re-login.  Once logged in, verify that the customization is present, if issues arise, please try to re-import the Model File again or contact ws@osnium.com for further assistance.

4. Note, once the Model File has been applied to the currently logged in Staff, please note that there might be additional Staff that need this Model File, if so, repeat these steps when logged in as the Staff or see Pull or Push Model File.


[bookmark: _Toc402513147]Exporting a Model File

Exporting a Model File from the currently logged in Staff Member of WS

1. Login to WS
2. Click on the Tools tab
3. Click on Edit Model File arrow, then Export Model File, from there select a folder to export the *.osm file to and provide a File Name
[image: ]
[image: ]

4. Click Ok to export, successful export message:
[image: ]



[bookmark: _Toc402513148]Pull or Push Model File

Push a Model File for an existing Staff Member
7. Login to WS
8. Click on the Tools tab
9. Click on Edit Model File arrow, then Distribute Model File
[image: ]
[image: ]

10. In the Applied Model Diffs, Use Model From is defaulted to the currently logged in Staff member.  
[image: ]

11. To take a Staff Members Model File, select it from Use Model From and select the Staff that contains the correct Model File
12. Select the users who will receive these changes, this is the list of Staff members who will receive the Model File.  Either click Add Users From Roles to select Staff Role based or click Add, to select each individual Staff member who will receive the Model File.

In the example below, we are to Use Model From Administrator, and sending the customization to the Staff UserName.
[image: ]

List of Users/Staff who will receive the changes once Ok is clicked 
[image: ]

13. Click Ok to send the Model File to the selected Users.
14. Inform each Staff that received the Model File and instruct them to Log off or Exit WS, then re-login to verify changes


Pull a Model File for an existing Staff Member
1. Login to WS
2. Click on the Tools tab
3. Click on Edit Model File arrow, then Distribute Model File
[image: ]
[image: ]

4. In the Applied Model Diffs, Use Model From is defaulted to the currently logged in Staff member, when Pulling, this should NOT User Mode From Administrator (as in this example, we are logged in as Administrator).  
[image: ]

5. To take a Staff Members Model File, select it from Use Model From and select the Staff that contains the correct Model File (ie: UserName)
[image: ]
6. Select the users who will receive these changes, this is the list of Staff members who will receive the Model File.  Either click Add Users From Roles to select Staff Role based or click Add, to select each individual Staff member who will receive the Model File.

In the pull example below, we are to Use Model From UserName, and sending the customization to the Staff Administrator.
[image: ]

List of Users/Staff who will receive the changes once Ok is clicked 
[image: ]

7. Click Ok to send the Model File to the selected Users.
8. In this example we were pulling from a Staff member to the currently logged in user Administrator, now that Administrator has a new Model File, we need to log off or Exit and re-login to verify.


[bookmark: _Toc402513149]Basic Role Configuration

Creating a new Role

1. Log to WS
2. Open the Main Menu, then Other and click Staff
3. Open an existing Staff Member and click on Roles
4. Click the Add button
5. In the list of Roles, click New
[image: ]

6. Name the Role (ie: Staff)
7. Can Edit Model will give the Staff additional access to the Edit Model button in the Tools tabs.  Providing access to this is not suggested, only during initial setup of WS.
8. Disable Customization will give the Staff the ability to right-click on a Detail View and Customize layout.  Providing access to this is not suggested, only during initial setup of WS.
9. Additional assistance regarding Permission can be provided by an Osnium Staff member, please contact ws@osnium.com if needed.


Editing an existing Role

1. Log to WS
2. Open the Main Menu, then Other and click Staff
3. Open an existing Staff Member and click on Roles
4. Locate the Role from the list and double click to open and edit as needed.  Note that each Staff that is associated with the newly edited Role will need to Log off or Exit and re-login for security to be in effect.  For troublesome Staff, manually Log off as needed to ensure security is at its fullest.


[bookmark: _Toc402513150]Updating Roles to avoid unnecessary changing/deleting of Service Codes
[bookmark: _Toc402513151]Demonstrating the issue(s)
As it currently stands, Staff logging into WS can open an existing Service Code and either change the Name or Delete it completely; demonstrated below:
1. Open a New or Existing Service Provided
[image: ]

2. Add at least one Service Code
[image: ]    [image: ]

3. Double-click on the added Service (Case Management), this will open the Service Code > Case Management for editing
[image: ]


[bookmark: _Toc402513152]How to update Roles to avoid changing/deleting of a Service Code
[bookmark: _Toc402513153]Opening a Staff Member and associated Role
· Open the Main Menu > Other > Staff
· Located an example Staff Member and Role
[image: ]



[bookmark: _Toc402513154]Editing the Role
1. Open the Role (example is Regular User)
[image: ]

2. Within the column Object, located Service Code[image: ]



· First suggestion is to uncheck Create and Write, this will remove the New button when Adding a Service Code to a Service Provided
a. Then Double-click on Service Code, this will open Type Permissions Details
[image: ]

b. Then open the Object Permissions tab and click New, put a checkmark in the Write column then open the … on Criteria, click the Text tab and paste the following:

     [Oid] = {00000000-0000-0000-0000-000000000000}

[image: ]

c. Click Ok, then Ok, then Save and Close on Role and Staff.

Unchecking Write will not allow the changing of Service Codes when Double-clicking.  If a new Service Code is needed, it is best to contact your WS Administrator for assistance.

[bookmark: _Toc402513155]Testing the changes
1. Log out of WS with an example Staff (Roles will only update when closing WS and re-logging in)
2. After login, the adding a Service Code should not show the New button
[image: ]

Further, when Double-clicking the added Service Code, the Name will be disabled (not editable)
[image: ]

* Please remember to update all Roles except for Administrators, if Administrators are having issues, it might be best to change that Staff to a Regular User and only login as an Administrator when needed.



[bookmark: _Toc402513156]Stop Staff > ‘Anonymous’ from being Deleted
Staff members are users that are allowed to login to the software, within the software, there are two Staff accounts that are created automatically; Administrator and Anonymous
Anonymous is an Staff member with little purpose, but affects the software greatly when deleted or no longer exists.  It is advised to avoid deleting or changing information about the Staff member Anonymous.
[bookmark: _Toc402513157]Add Role permissions to NOT Modify and/or Delete UserName Anonymous
To stop the ability to Modify or Delete, each Role in the software will need to apply the following modification:
1. Login to WS (if error occurs, please contact Osnium at ws@osnium.com to Restore Anonymous)
2. Open the Main Menu
3. Hover the mouse over Other
4. Click to open Staff in a List View
[image: ]

5. Locate the Staff > UserName of Administrator (not Anonymous)
6. Click and open this Staff member, then locate the Roles tab
[image: ]

7. By default, Administrator should have the Role of Administrators
8. Click and open the Role named Administrators to add “less” permissions Staff, specifically UserName Anonymous.
[image: ]

9. In the tab Permissions, sort the Column Object 
[image: ]

10. Locate the Object with the name of Staff
[image: ]

11. Uncheck the following Columns: Write and Delete
[image: ]



12. Now click on the word Staff, under the Column: Object
13. Click on the Object Permissions tab, then New (this will automatically add a new row)
[image: ]

14. Click the area further to the right on the Column: Criteria
[image: ]* Note: The [image: ] is not visible until the mouse is hovering over the date column

15. Click the [image: ] to open and create a Criteria Filter 
[image: ]

16. Open the Text tab
[image: ]

17. Copy and Paste the following text into the text area

Text to copy:
          [User Name] <> 'Anonymous'

18. Once Pasted properly, the window should look like the sample below:
[image: ]

19. Click Ok
20. Ensure that each of the check boxes are Checked (this is important)
[image: ]

21. Click Ok, then Save and Close on the Role (Administrator)
22. Log off of WS
23. Re-login to WS (this will update the permissions on the current computer that is logging into WS
24. Navigate to Staff and test that the Staff with UserName of Anonymous is unable to be Modified or Deleted
25. Repeat from Step #5 to Step #21 with each Staff that has a different Role

* Important: Ensure that ALL ROLES in the software are updated with this change or the modification/deletion of Anonymous may continue.

* Important:  Each computer that was logged into WS should log off and re-login for the changes to be in effect.





[bookmark: _Toc402513158]Filtering in a List View
Within the software, there are many ways to filter information on List View (grid of information).  These types of filtering will allow the user to quickly filter the information as the fly or setup permanent filters that can be applied as needed.  Please review the various ways of filter to determine the best solution for various situations.
[bookmark: _Toc402513159]Full Text Search (Ribbon)
The Full Text Search is available on List Views that are in their own separate tab of the software (this search is NOT available on a List Views embedded within other details).
Full Text Search
[image: ]

Full Text Search and Client List View
[image: ]




Searching
Full Text Search is a simple text box, enter the word, words or phrase, click the find icon or hit the [Enter] button on the keyboard.
[image: ]
Removing/Clearing search
When a search has already been applied, removing or clearing the search can be accomplished by deleting the text in the text box followed by clicking the find icon or hit the [Enter] button on the keyboard.
What does the Full Text Search do
The Full Text Search will search the main fields on that Object (ie: Client), it will not search major module or tab related information (ie: Activity Sessions, Stays, Cases, Clinical Notes, etc).  
For example, if searching Clients for “female”, this will return Clients that have the word “female” in their main profile of information (ie: First Name, Last Names, Notes, Gender, Ethnic Origin, etc).  The search will produce results even if the information is not displayed on the screen (either List View or Detail View)
[image: ]
[bookmark: _Toc402513160]Filtering (Drop Down in Ribbon)
Filtering from the drop down is one of the more advanced areas for filtering.  In this area, users are able to create New and Edit existing filters.  The explanation of using the Filter Editor will be explained in a separate document which is currently under development, if you require more information please contact Osnium at 1-888-676-4861 x2 or ws@osnium.com.
Filtering Drop Downs are quite powerful and useful, if used properly.  If a user was to apply a filter, then close the software, the next time the user logs in the filter will still be applied.  This is a caution to all users as many of the users will apply a filter, get the results needed and leave the filtering applied.  Only to be confused later in the day or so because the user is unable to see the intended results (ie: entire Client list) because they neglected to set the Filtering Drop Down back to All Items.
Filtering Drop Down
[image: ]
Filtering Drop Down on a Client List View
[image: ]
Applying an existing Filter
1. Locate the filter drop down and click the arrow near the right side of the drop down [image: ].
2. Scroll (if necessary) to find the filter, then click on the selection
[image: ]

3. With the Filter applied, the List View (ie: Clients will now only show Clients that have a Stay and at least one of the Stays has a Discharge Date that is empty/null/blank).
[image: ]

In the example above, the Client list count was 3, applying the Active Stays filter brought the count to 1.
Remove applied Filter
1. Locate the filtering drop down
2. Select the top option; All Items
[image: ]



[bookmark: _Toc402513161]Find Panel
The Find Panel is a simple tool to search the Columns that are visible on the List View, columns NOT visible will not be searched.
Find Panel
[image: ]
Showing the Find Panel
1. Right click on a Column Heading
2. Select Show Find Panel
[image: ]

Searching the Find Panel
To search with the Find Panel, enter the desire text into the text box, in the example below, we are searching for “Female”
[image: ]
Removing/Clearing the Find Panel Text
Removing or clearing the text on the Find Panel can be accomplished two ways
1. Click the Clear button on the Find Panel, this will remove the text and clear the search
[image: ]

2. Highlight the existing text (ie: Female), then delete it.  After a second or two, the results should be returned like there was no search applied (or click Find)

Searching with the history in the Find Panel
Each search performed with the Find Panel will added to a temporary history list that is cleared when the tab (ie: Client List View) is closed
To access the history, click on the drop down arrow to the right of the Text Box and select an entry from the search history list
[image: ]



[bookmark: _Toc402513162]Auto Row Filter
The Auto Row filter is a simple way to search the List View by a specific column. 

Auto Row Filter
[image: ]
Show Auto Row Filter
1. Right click on a Column Heading
2. Select Show Auto Filter Row
[image: ]

Hide Auto Row Filter
1. Right click on a Column Heading
2. Select Hide Auto Filter Row
[image: ]

[bookmark: _Toc402513163]Quick Auto Filtering
This technique can be used to quickly filter out a specific column of data, much like the Auto Filter Row.  Note, more than 1 column can be filtered, simple repeat the steps below.
1. Hover the mouse over a Column Heading
2. Within the Column Heading, click the [image: ] (filter icon)
[image: ]

3. The filtering options will now appear in a drop down like control
[image: ]

4. Select one of the many options to only see the selected option, in this example, “Client Type #1” is selected, returning only Clients with Client Type = Client Type #1
[image: ]

Note, at the bottom of the List View, there is now a Filtering Summary (discussed later in this document) that can be used to enable or disable the applied filter in this example
[image: ]




Also, because we have the Show Auto Filter Row visible/enabled (discusses earlier in this document), the Quick filter applied is also showing the filtering (ie: Client Type #1 under Client type Column Heading)
[image: ]

[bookmark: _Toc402513164]Filter Editor
The Filter Editor allows users to build complex filter criteria with an unlimited number of filter conditions.  Additional information can be provided as requested, please contact support at 1-888-676-4861 x2 or ws@osnium.com. 
Accessing Filter Editor (example #1)
[image: ]


Accessing Filter Editor (example #2)
1. Right click on a Column Heading
2. Select Filter Editor…
[image: ]

3. Filter Editor (blank or empty)
[image: ]

Filter Editor (example of Active Stays on a Client)
[image: ]

[bookmark: _Toc402513165]Filtering Summary
The Filtering Summary is a control panel for Auto Filtering Row and Quick Auto Filtering, but it does not have any relation with the Filtering (Drop Down in Ribbon) in the Ribbon.  Please be aware that the user may need to remove a Filtering (Drop Down in Ribbon) in order to use Auto Filtering Row and/or Quick Auto Filtering and vice-versa
Filtering Summary
[image: ]
Remove/Delete filtering
[image: ]
Temporarily Enable or Disable filtering string
[image: ]
Current Filter (enabled or disabled)
[image: ]
Access Filter history list
[image: ]

Filter history list (from arrow in example above)
[image: ]
Advance Edit Filter
[image: ]


[bookmark: _Toc402513166]Roles and Permissions
Roles and associated permissions can be setup for a Staff Member or a group of Staff Members, these setting can limit the ability for Staff to change specific information or data.  Below is a suggestion for setting up Permissions.
It is always suggest to leave the Role Administrators untouched and associated to the UserName Administrator.  
[bookmark: _Toc402513167]Suggested Permissions for WS Admin (full access)

1. Create a New > Role for all WS Admin to use by default (ie: "WS Admin (full access)")
a. Check: Can Edit Model
b. Uncheck: Disable Customization, Disable Required Fields and Initial Value

2. Required Fields on New is suggested (ie: New > Gender > Name must be Required)
* Note, this change will affect all users using WS
[bookmark: _Toc402513168]Suggested Permissions for Staff (limited access)

1. Create a New > Role for all Staff to use by default (ie: "Staff (limited access)")
a. Uncheck: Can Edit Model
b. Check: Disable Customization, Disable Required Fields and Initial Value
c. Deny Delete from all Objects
d. Deny Write from: Role
e. Deny all except Navigate from Category: Security
f. Deny Write and Deny Create from all the Objects that are needed for reporting (ie: Gender, Housing Type, Program Type, Ethnic Origin, etc)
g. For objects that are multiple (ie: Secondary Activity Session Types, Income Source (at entry and exit):
i. Deny Write and Deny Create, then double click the Row to open a Detail View, go to Object Permission tab, click New
ii. Check: Write
iii. In the Criteria, add this: [Oid] = {00000000-0000-0000-0000-000000000000}

2. Required Fields on New is suggested (ie: New > Gender > Name must be Required)
* Note, this change will affect all users using WS
Please feel free to contact Osnium Support at support@osnium.com.


[bookmark: _Toc402513169]Initial Value on a Field
[bookmark: _Toc402513170]What is an Initial Value
An Initial Value is data that will be automatically entered when creating a new entry (ie: Client).  An example of Initial Value would be Gender, by default, the new Client could set to Gender = Unknown, indicating that Gender is Unknown until asked or determined by the user.  If Unknown is incorrect, then the user would simply change to Male, Female, etc.
[bookmark: _Toc402513171]Set Initial Value
1. Open the Detail View that the Initial Value is requested (ie: Client)
2. Locate the field on the Detail View (ie: Gender)
a. If the field is NOT visible on the Detail View the Staff member will need to customize the Detail View to have the field, close the Detail View and reopen. Right clicking on the newly added field will not work until reopening of Detail View.
3. Click the field until the field is highlighted
	Not selected
[image: ]
	
Selected




4. Select the value of the Initial Field (ie: Unknown)
[image: ]

5. Right Click on the field then select Set As Initial Value
[image: ]

6. Close the Detail View (Save as needed), create a new record (ie: Client) to confirm Set As Initial Value
[image: ]
Note, Initial Value can be set on the following types of Fields: Text Box, Long Text Box, Drop Down, Number, Number with Decimals and Dates.
[bookmark: _Toc402513172]Clear Initial Value
1. Open the Detail View that the Initial Value is applied (ie: Client)
2. Locate the field on the Detail View (ie: Gender)
3. Click the field until the field is highlighted
4. Right click on the field
5. Select Remove Initial Value
[image: ]



[bookmark: _Toc402513173]Limited Staff from Setting or Clearing Initial Value
Staff Roles can be tailored to NOT allow specific Staff to Set Initial Value or Clear Initial Value, this can be accomplished by opening an existing (or creating a new) Role and checking Disable Required Fields And Initial Values
[image: ]
This will limit the Staff from being able to right click and seeing Set Initial Value or Clear Initial Value.  Upon changing an existing Role, all Staff associated to that Role will need to log off or exit the software and re-login for the change to be in effect.


[bookmark: _Toc402513174]Required Fields
[bookmark: _Toc402513175]What is a Required Field
A Required Field is a Rule that can setup on specific Detail Views so that Staff is informed on Save if one or many fields that are missing values.
Reporting is the number one reason to have Required Fields setup, this will allow a more accurate reporting period because some field (ie: Gender) default to blank/empty, but many Staff require this data even if it is not known (ie: Unknown).
[bookmark: _Toc402513176]Make a Required Field
1. Open the Detail View that the Required Field is to be setup (ie: Client)
2. Locate the field on the Detail View (ie: First Name)
a. If the field is NOT visible on the Detail View the Staff member will need to customize the Detail View to have the field, close the Detail View and reopen. Right clicking on the newly added field will not work until reopening of Detail View.
3. Right Click on the field then select Make Field Required
[image: ]

4. Now the software will ask if this field (ie: First Name) needs to be required everywhere.  In most case, selecting No is best (ie: if required only for Client), however, if this field needed to be Required on another Detail View that Client is create then Yes is the best selection (although not the greatest example).
[image: ]

5. Now that the field is Required, the field will now show a Red border around the field, this is used to visually indicate that this is Required
[image: ]

6. Saving the Client with no First Name will produce the following Required Field message or visual notifications

Message Box
[image: ]

Field
[image: ]



[bookmark: _Toc402513177]Clear Required Field
1. Open the Detail View that the Required Field is to be setup (ie: Client)
2. Locate the field on the Detail View (ie: First Name)
a. If the field is NOT visible on the Detail View the Staff member will need to customize the Detail View to have the field, close the Detail View and reopen. Right clicking on the newly added field will not work until reopening of Detail View.
3. Right Click on the field then select Clear Field Required
[image: ]

[bookmark: _Toc402513178]Limited Staff from Setting or Clearing Initial Value
Staff Roles can be tailored to NOT allow specific Staff to Make Required Field or Clear Required Field, this can be accomplished by opening an existing (or creating a new) Role and checking Disable Required Fields And Initial Values
[image: ]
This will limit the Staff from being able to right click and seeing Make Required Field or Clear Required Field.  Upon changing an existing Role, all Staff associated to that Role will need to log off or exit the software and re-login for the change to be in effect.


[bookmark: _Toc402513179]Basic Customization
Accessing Customization in a Detail View
The ability to access the customization window depends on the Role(s) the logged in Staff Member is assigned to.  A Staff Member must have a Role with Disable Customization being unchecked.  This will allow the Staff Member to be on a Detail View (ie: Client), right click on a field text (the display, not the data) and see options to Customize Layout.
[image: ]
Customize Layout 
Selecting Customize Layout will show the Customization window for a Detail View
[image: ]
Reset Layout 
Selecting Reset Layout will remove ALL customization to that Detail View as if the software was recently installed (note, this will NOT delete Clients, etc)

[bookmark: _Toc402513180]Customization Window
The Customization window contains many features to change Detail Views
Undo / Redo
[image: ]
Undo and Redo gives the Staff member the ability to make changes to the Detail View with an option to Undo (revert) each step.  Further, if undo is click too many times, Redo can be used to cycle back what was undone.
Hidden Items tab
Default Items
[image: ]
These are “controls” that can modify the layout of the Detail View to be easier to separate data, expand and collapse areas, etc

Empty Space Item can be used to create an empty space on the Detail View
[image: ]

Label can be used to identify an area or provide text/instruction within an area of the software
[image: ]

Separator can be used to create a vertical or horizontal line for visual separation of information
[image: ]

Splitter if used and positioned properly, can be used to separate two fields (or lists), then allowing the Staff to hover over the Splitter and slide the line left to right (or top to bottom) condensing one side and expanding the other, allowing more details to be shown as needed
[image: ]
Fields ready to be added to Form
By default, there shouldn’t be any fields ready to be added to the form
[image: ]

If there are any it would look similar to the screen shot (below)
[image: ]
Note, continue reading this guide to add fields here (screen shot above)

Layout Tree View
[image: ]
Layout Tree View is a parent to child visual representation of the Detail View and its many fields and other items, in most case, this will not need to be accessed.
Add / Remove
[image: ]
Add
The Add button is where you can access the Object Model; to add fields into the Fields ready to be added to Form.
Remove
The Remove button is to remove Fields ready to be added area.  The Remove button is disabled if there are no fields to remove from the customization window.



[bookmark: _Toc402513181][bookmark: _GoBack]Basic Customization
Accessing Object Model and Adding fields from Customization Window
To access the Object Model, click the Add button from the Customization window
1. Click the Add button in the Customization window
[image: ]

2. Object Model window will now appear and present all the information/data that can be customized onto a Detail View.  Note, only information related to the Client will show up because customization is being taken place on the Client
[image: ]

a. Dark (black) font fields are currently NOT customized, these would be the fields to pay attention to when adding to a Detail View
b. Light (gray) font fields are currently customized on the Detail View or are ready to be customized in the customization window.

3. Select (highlight) 1 or many fields (hold CTRL then Click, repeat as needed), then click Add to add these fields into the fields ready to be added area of the customization window
[image: ]

4. After clicking Add, the fields will become available for drag and drop onto the Detail View
[image: ]

5. Drag and drop the field onto the Detail View
[image: ]
The black line on the Detail View will show where the field will be placed when the mouse button is released, this will greatly increase the accuracy of where the field is placed before placing it
[image: ]

6. Repeat the above steps until all the desired fields are customized onto the Detail View.  Note, perform customization is small batches by closing all the Detail Views and restarting the software to commit the changes to ensure there is no loss of customization.



7. Close/Exit the Customization Window when all the customization tasks are completed[image: ]

8. Fields and other items are now available in Detail View after closing Customization window
[image: ]
[bookmark: _Toc402513182]Quick Tips when customizing

1. Never customize a Detail View (ie: Client) when you have 2 or more Client Detail Views open.  This may cause and issue when you close out of the software and re-log back in because the software will select the other Detail View as the customization, thus losing the work the Staff member attempted to complete.

2. Never customize when the Staff member is logged in on another Workstation (two logins in use of the same username), this may cause and issue when you close the software (as well as the other workstation), the software will select one of the two to save, thus losing the work the Staff member(s) attempted to complete.


[bookmark: _Toc402513183]Basic Customization
Modifying Fields, Group, Tabs
[bookmark: _Toc402513184]Manipulating Fields
Modifying existing fields that are already on the Detail View do not require the use of the Customization Layout window, but the Customization window must be visible/enabled, suggestion is to move the window to the side and focus on the Detail View itself.
[image: ]


Now that we have full access to the Detail View, right click on a field or item to see its properties or functions
	Field
[image: ]
	Group:
[image: ]
	
Tab




· Hide Customization Form - Closes out of the Customization and return the user to the Detail View for data entry.  This is the save function as click the X on the Customization window.
· Reset Layout - This will remove ALL customization to that Detail View as if the software was recently installed (note, this will NOT delete Clients, etc)
· Rename - This will also the current field to be renamed.  Rename is only available if the text (field name, ie: First Name) is Visible as Hide Text will make the text invisible
[image: ]

· Hide Text - This will hide the text (field name, ie: First Name) leaving the input (ie: text box, check box, drop down, etc)
· Text Position - This will move the position of the text relative, options include: Top, Bottom, Left, Right.  Most fields are defaulted to Left.  List View are default to Top. 
[image: ]

Top
[image: ]

Bottom
[image: ]
Left
[image: ]

Right
[image: ]

· Hide Item - This will remove the field from the Detail View and place it in the Customization window (no data will be deleted)
· Group - This will create a Group box containing all the fields that where selected when Group was clicked (other fields can be dragged and dropped after a group is created).  If right clicking on a Group, additional options include: Ungroup, Create Tabbed Group
[image: ]

· Ungroup - This will remove the highlighted Group box
· Create Tabbed Group - This will create a Tab from the selected Group.  In order to make a Tab, a Group must be selected
[image: ]

· Create EmptySpace Item - This will create an Empty Space Item to the right or bottom of the field.  This is the same function as Empty Space Item in the Customization window

· Size Constraints - This will allow of Lock the field’s: Size, Width, Height.  Also Reset to default and Free sizing
[image: ]

· Appearance - This will change the field name (ie: First Name) display by: Bold, Italic, Underline, Color, Clear Formatting
[image: ]
[bookmark: _Toc402513185]Adding Tabs to existing Tab lists
By default, various Detail Views have Tabs containing information and it is possible to create additional Tabs and move them within the existing Tabs

To add a new Tab to an existing Tab list
1. Access the Customization window (ie: right click > Customize layout)
2. Locate an existing Tab list, position cursor at the beginning or end of the list and right click (this should highlight the entire Tab list area) then click Add Tab
[image: ]

3. Once the tab has been added, right click and select Rename is necessary
[image: ]

4. To position the Tab in another location, click, hold and drag the Tab between the desired tabs and release the mouse button.  Dragging and dropping to another Tab list is also possible
[image: ]


[bookmark: _Toc402513186]Basic Customization
Accessing Customization from List View
To access the Customization window from a List View can be accomplished by locating the List View and right clicking on a Column, then selecting Column Chooser.  This will make the Customization window visible for the List View
[image: ]

Customize
Selecting Column Chooser will show the Customization window for a List View
[image: ]


[bookmark: _Toc402513187]Customization Window
The Customization window contains many features to change Detail Views
Fields ready to be added to List View
By default, there shouldn’t be any fields ready to be added to the form
[image: ]

If there are any it would look similar to the screen shot (below)
[image: ]
Note, continue reading this guide to add fields here (screen shot above)
Add / Remove
[image: ]
Add
The Add button is where you can access the Object Model; to add fields into the Fields ready to be added to Form.
Remove
The Remove button is to remove Fields ready to be added area.  The Remove button is disabled if there are no fields to remove from the customization window.


[bookmark: _Toc402513188]Basic Customization
Accessing Object Model and Adding fields from Customization Window
To access the Object Model, click the Add button from the Customization window
9. Click the Add button in the Customization window
[image: ]

10. Object Model window will now appear and present all the information/data that can be customized onto a Detail View.  Note, only information related to the Client will show up because customization is being taken place on the Client
[image: ]

a. Dark (black) font fields are currently NOT customized, these would be the fields to pay attention to when adding to a Detail View
b. Light (gray) font fields are currently customized on the Detail View or are ready to be customized in the customization window.

11. Select (highlight) 1 (List Views can only add 1 field at a time, unlike Detail View Adding), then click Add to add this field into the fields ready to be added area of the customization window
[image: ]

12. After clicking Add, the fields will become available for drag and drop onto the Detail View
[image: ]



13. Drag and drop the field onto the Detail View, alternatively, double click the field (ie: Session Type) and the field will be automatically added to the end of the list.
[image: ]
The two arrows on the List View Columns will show where the field will be placed when the mouse button is released, this will greatly increase the accuracy of where the field is placed before placing it
[image: ]

14. Repeat the above steps until all the desired fields are customized onto the List View.  Note, perform customization is small batches by closing all the Detail Views and restarting the software to commit the changes to ensure there is no loss of customization.



15. Close/Exit the Customization Window when all the customization tasks are completed
[image: ]

16. Field and other objects are now available in List View after closing Customization window
[image: ]
[bookmark: _Toc402513189]
Removing fields from a List View
To remove a field from a List View, 
1. Right click on the Column Heading
2. Select Remove This Column[image: ]
The Customization window does not need to be visible/enabled for this task



[bookmark: _Toc402513190]Quick Tips when customizing

3. Never customize a List View (ie: Person Activity) when you have 2 or more Person Activity List Views open (or Client Detail View in this specific example).  This may cause and issue when you close out of the software and re-log back in because the software will select the other List View as the customization, thus losing the work the Staff member attempted to complete.

4. Never customize when the Staff member is logged in on another Workstation (two logins in use of the same username), this may cause and issue when you close the software (as well as the other workstation), the software will select one of the two to save, thus losing the work the Staff member(s) attempted to complete.


[bookmark: _Toc402513191]Basic Customization
Sorting a List View by various fields
List Views can be sorted by not only 1 field but as many as needed.  By default, most List Views will not be sorted; this can be determined by looking for an arrow in each Column in the List View

[bookmark: _Toc402513192]Sorting viewing
No Sorting
[image: ]
First Name Sorted Ascending (A-Z)
[image: ]
Last Name Sorted Descending (Z-A)
[image: ]




[bookmark: _Toc402513193]Clear All Existing Soring
To Clear Sorting for all Columns, right click on a Column and select Clear Sorting
[image: ]


[bookmark: _Toc402513194]Sort one field
To sort by one field (and remove all previous sorting), locate and click on an existing Column Heading (ie: First Name).  Click one time to sort Ascending (A-Z); click a second time on the same column heading to reverse the sort order to Descending (Z-A).
[bookmark: _Toc402513195]Sort one or many fields
1. Right click on an existing Column Heading (ie: First Name Ascending)
2. Select Sort Ascending or Sort Descending
[image: ]
3. Repeat on another Column Heading to further sort (ie: Last Name Descending, this will sort First Name Ascending, then Last Name Ascending)
[image: ]
The Column Headings will show how they are sorted, however, they do not show the sort in the order they were applied.


[bookmark: _Toc402513196]Sort Grouping
To sort a Grouping, the Group By Box must be visible
1. Right click on a Column Heading
2. Select Show Group By Box, if the Group By Box is already visible, it will say Hide Group By Box (this can be used once sorting is complete)
[image: ]

3. Now that the Group By Box is visible, click on each Field to change the Sorting from Ascending to Descending (and vice versa)

After clicking on Gender (the arrow is now indicating Descending)
[image: ]

4. Right click on the Group By Box area and select Hide Group By Box.  It is recommend to close the Group By Box once Sorting is complete
[image: ]


[bookmark: _Toc402513197]Basic Customization
What is Grouping and how to use it
Grouping is a feature in the software where the user can group common information together, allowing enhanced visual understanding or simple separation of information.  In examples below, Client List View is being used along with limited information in Client Type and Gender.
[bookmark: _Toc402513198]Show Group By Box
1. Right click on a Column Heading
2. Select Show Group By Box
[image: ]



3. The Group By Box will show a waterfall type display of the groupings that are applied

No Grouping
[image: ]

Single Field Grouping
[image: ]

Multiple Field Grouping
[image: ]


[bookmark: _Toc402513199]Hide Group By Box
Option 1
1. Right click within the Group By Box area
2. Select Hide Group By Box
[image: ]
Option 2
1. Right click on an existing Column Heading
2. Select Hide Group By Box
[image: ]



[bookmark: _Toc402513200]Group By a Field/Column
Option 1
1. Right click on a Column Heading (Group By Box does not need to be visible/enabled)
2. Select Group By This Column
[image: ]

Group By Column (ie: Client Type)
[image: ]



Option 2
1. Show Group By Box
2. Click on an existing field from the Column Heading, hold and drag the field into the Group By Box area, if there are existing Grouping, move the mouse before, between or after the existing Groupings

No existing Grouping
[image: ]

Existing Grouping
[image: ]


[bookmark: _Toc402513201]Re-Ordering Grouping(s)
1. Show Group By Box
2. Click, hold and drag an existing grouping to another area inside the Group By Box, release mouse when ready
[image: ]
In this example, Client Type (first in the list of groupings) is being reordered to be the last grouping in the list

[bookmark: _Toc402513202]Manipulating Group By fields on a List View
Various options are available to view the data in the List View
Expanding specific field Grouping from a List View
Click on the [image: ] next to the Grouping to expand and show the associated data
[image: ]
Collapse specific field Grouping from a List View
Click on the [image: ] next to the Grouping to collapse and hide the associated data
[image: ]


Expanding all Groups from the Group By Box
Options 1 (expand specific field grouping)
1. Right click on a Field in the Group By Box
2. Click Full Expand
[image: ]

After Full Expand
[image: ]


Option 2 (expand all field groupings in the Group By Box)
1. Right click in the Group By Box, but not on a field (click the background)
2. Click Full Expand
[image: ]

After Full Expand for all fields grouped
[image: ]


Collapsing all Groups from the Group By Box
Options 1 (collapse specific field grouping)
1. Right click on a Field in the Group By Box
2. Click Full Collapse
[image: ]

After Full Collapse
[image: ]


Option 2 (collapse all field groupings in the Group By Box)
1. Right click in the Group By Box, but not on a field (click the background)
2. Click Full Collapse[image: ]

After Full Collapse for all fields grouped
[image: ]


[bookmark: _Toc402513203]Ungroup specific field
1. Show Group By Box
2. Right click on a grouping field
3. Select UnGroup
[image: ]

After UnGroup
[image: ]



[bookmark: _Toc402513204]Clearing Grouping
To remove all field Groupings
1. Show Group By Box
2. Right click in the Group By Box, but not on a field (click the background)
3. Select Clear Grouping
[image: ]

After Clear Grouping
[image: ]



[bookmark: _Toc402513205]Using the Sort By Summary
The Sort By Summary can be used to Group by a field (ie: Gender), then sort the Count of each Gender Grouping by Ascending or Descending.  This will allow a List View displaying Gender Grouping to show the group (ie: Female) at the top if sorted Descending as it has 2 Females, where Male is only at a Count of 1.
1. Show Group By Box
2. Right click on a field to Sort by Summary
3. Select Sort By Summary
4. Then select one of the many options (ie: Count by ‘Gender’ – Sort Descending)
[image: ]

In this example, the Sort Summary Descending is too obvious, however, trying this with other fields like Client Type, Race, Ethnicity, etc may prove to have better results.

After applying Sort by Summary, the arrow on the field (ie: Gender) has a line then the arrow, this will indicate that  Sort by Summary is being applied to this field 

	Ascending
[image: ]
	Descending
[image: ]




[bookmark: _Toc402513206]Clearing Sort By Summary
Option 1
1. Show Group By Box
2. Right click on a field (ie: Gender)
3. Select Clear Summary Sorting
[image: ]

Option 2
1. Show Group By Box
2. Click on the field (this will clear the Summary Sorting and apply Ascending of Descending sorting)
[bookmark: _Toc402513207]Group Summary Editor
Please contact Support at 1-888-676-481 x2 (or support@osnium.com) for additional assistance in this feature.


[bookmark: _Toc402513208]Installing WS
[bookmark: _Toc402513209]Locate downloaded files on Computer
Open the downloaded WS file on your computer (ie: WS 11.2.8.zip), this file could have been downloaded to the Desktop, Download or another location.
[image: ]
[bookmark: _Toc402513210]Open Zip File and run installation
Once the zip file is open, you should see the following file(s)
[image: ]
Open Setup.msi to begin installing WS.  
Please remember to Uninstall WS if you are updating to a newer version.


[bookmark: _Toc402513211]Installing WS
Click Next on the Welcome screen to WS Setup Wizard, Cancel to stop installation at anytime
[image: ]
Choose the installation directory, default is recommended, changing the Folder location is only suggested to advanced users.  Access to WS can be provided to Everyone (default) or Just Me (the current user that is logged into Windows)
Please note the Folder location for future reference 
(ie: C:\Program Files (x86)\Osnium Software Inc\WS)
Click Next to continue
[image: ]
Click Next to begin installation of WS
[image: ]
WS will now begin installation (this may take a few minutes)
[image: ]
Once the installation is complete, you will be presented with the following message if successful, click Close to close the installation wizard as it is complete
[image: ]
WS is installed but it is not connected to any specific database


[bookmark: _Toc402513212]Connecting WS to SQL Server
[bookmark: _Toc402513213]Edit the configuration file of WS
Once WS has been successfully installed, the next step is to connect WS to a database.  
In most situations this database provider will be SQL Server; this should be installed already, if it hasn’t please return to the main area of documentation for installation of WS.
To edit the configuration file of an installed WS; navigate using Windows’ File Explorer to the installation directory of WS (this should be the Folder location in previous steps of installing SQL Server; ie: C:\Program Files (x86)\Osnium Software Inc\WS)

Typical File Explorer Icon: [image: ]

[image: ]
[image: ]
Now that the File Explorer is at the proper location, locate WS.Win.exe.config (the Type should be CONFIG File, not Application).[image: ]
Right click on WS.Win.exe.config > Open With > Choose default program…[image: ]
Selecting Notepad is the easiest to use
[image: ]
Once the file is opened in Notepad, locate name=”ConnectionString” and name=”DashboardConnectionString”, these are the two areas that must be changed in order for WS to connect to the properly database
[image: ]

Text from config file:
	
<add name="ConnectionString" connectionString="Integrated Security=SSPI;Pooling=false;Data Source=.\SQLEXPRESS;Initial Catalog=WS" />


	
<add name="DashboardConnectionString" connectionString="Integrated Security=SSPI;Pooling=false;Data Source=.\SQLEXPRESS;Initial Catalog=WS" />




Find and replace the following information:
· Remove Integrated Security=SSPI;
Replace with User ID=sa; Password=[Password];
Advanced IT users can use Integrated Security=SSPI; if setup with Windows Authentication
· Remove [Password] 
Replace with the password supplied during installation of SQL Server (this should be the SA Password in previous steps of installing SQL Server)
· Remove Data Source=.\SQLEXPRESS; 
Replace with Data Source=[SERVERHOSTNAME]\[SQLEXPRESS];
Replace [SERVERHOSTNAME] with Server’s ComputerName  or HostName
Replace [SQLEXPRESS] with SQL Server install’s Named instance, default installations should be SQLExpress.
· Initial Catalog=WS; in most cases will stay the same

Save the config file to overwrite the old version.  If you are unable to save, relocate the file to your Desktop, then copy the Desktop file to the WS installation directory.  This issue occurs because Windows does not want most users Navigating into Program Files and modifying, however, this is required to successfully complete the installation of WS.
Now that the config file is Saved, close all instances of WS (if any are still open with errors), then open WS from the Desktop of Start Menu.  If an error message pops up there could be numerous issues with the installation and/or setup.  Please recheck the installation, setup or config file to ensure all information is correct.  If the problem continues to exist please contact ws@osnium.com with subject line Config file help, then containing as much information and details about the installation/setup.

Successful installation of WS:
[image: ]
Now that SQL Server and other various details have been resolved you can now login to WS using the following details if no one has ever logged into the software:
UserName: Administrator
Password: ABC123!
Once you enter the password and Log On, you will be asked to change the default password, Osnium suggests ABC123 (like below) as this will make support easier for Osnium in the future.
[image: ]
If a database was restored (from data conversion, etc) then the suggestion first login is:
UserName: Administrator
Password: ABC123
 
Successful Log On to WS will bring the user to the Person tab.
[image: ]

[bookmark: _Toc402513214]Installation of many Workstations
If install of WS is required on many workstations, Osnium suggests that once one PC/Workstation is setup and verified, then copy the WS install file (Zip file) and WS.Win.exe.config to either a USB Key or Shared Directory.  This way, the IT can install WS and replace config file quickly and effortlessly.
* Alternative connection types can be used; for additional references please see: www.connectionstrings.com


[bookmark: _Toc402513215]Installing SQL Server 2008 Express

Open/Execute the downloaded file “SQLEXPRWT_x86_ENU.exe” or “SQLEXPRWT_x64_ENU.exe”.
[image: ]  then 
[image: ]

Please wait while the exe extracts the files
[image: ]

If Windows UAC is enabled, please allow the program to make changes by clicking Yes
[image: ]
Followed by a few popups that we will have through
[image: ]
A typical installation process looks similar to these instructions:
Create a New installation or add feature to an existing installation
[image: ]
License Terms will be presented, check I accept the license terms., then click Next >
[image: ]
Setup will now Setup Support Files, please waiting for this to finish
[image: ]
Further waiting
[image: ]
Feature Selection does not require any changes for the average setup/user, click Next
[image: ]


Instance Configuation; this area allow you to specify the SQL Server’s Instance, Onsium suggests that SQLExpress (the default) be used; however, renaming SQLExpress is possible.
Please note the Named instance (ie: SQLExpress) for future use of configuring the Osnium’s software
[image: ]


Now that we have a Named Instance, we can further configure this server instance in Server Configuration, set SQL Server Browser from Disabled to Automatic, this will allow other computers to access the SQL Server’s instance (ie: SQLExpress).  Note, Firewalls and/or port setup will affect connectivity to this Instance, but setting the SQL Server Browser now will allow us to omit a step later on in the setup process.  Click Next when ready
[image: ]


Database Ensure Configuration, this section allows configuration of either Windows Authentication Mode or Mixed mod (both Windows Authentication and SQL Server Authentication).  Osnium recommends Mixed Mode, and then setting will then require a Password and Confirm Password, this will be used with the SA username.  Suggestion of password would be osniumws or osniumclinicnd.
Please note the SA as the User Id and Password (ie: osniumws or osniumclinicnd) for future use of configuring the Osnium’s software
[image: ]
Error Reporting, simply click Next to proceed forward
[image: ]
Installation Progress screen will install the SQL Server instance and may take a while
[image: ]
Installation is complete once this screen appears; Close the window and all other associated install windows
[image: ]


[bookmark: _Toc402513216]Backup a SQL Database to a file

1. Open Start Menu > Microsoft SQL Server 2008 R2 > SQL Server Management Studio
2. Connect to the appropriate instance of the Microsoft SQL Server Database Engine, in Object Explorer; click the server name to expand the server tree.
[image: ]

3. Expand Databases
4. Right Click on the database to backup, Tasks > Back Up…
[image: ]



5. Remove any existing backups path (as they are not needed or would “double” backup if using the same one over and over)
[image: ] (before)
[image: ] (after)

6. Click Add (to create a database *.bak file in a specific location)
[image: ]

7. Selecting a Backup Destination, click the … at the end of File Name, then provide the file name of the backup that is being created.  Osnium would suggest to prefix the software name (ie: WS or ClinicND), then an underscore (ie: _) followed by a standard date format (ie: 20120101).
[image: ]
[image: ]
Note, default backup folder depends on the version of Windows and SQL Server, however a typical folder path is as follows: 
C:\Program Files\Microsoft SQL Server\MSSQL10_50.SQLEXPRESS\MSSQL\Backup

8. Final step is to verify or transfer to the file to another media type other than the Server’s hard drive.  Osnium would suggest copying the *.bak file to another PC or USB Key with sufficient space in case of any major disaster at the location of the server.  

Note, keep in mind that the database backup may contain confidential information and should not be shared over the internet without secure password or transfer of the file.



[bookmark: _Toc402513217]Restoring a database file to SQL Server
North Carolina has a default database when installing WS for the first time, please see http://osnium.com/NCCADV > Installation of WS for more details (or link below).
Default NCCADV Database: http://builds.osnium.com/Support/nc/WS_NC.zip
1. Close all connections to the database about to be restored
2. Open Start Menu > Microsoft SQL Server 2008 R2 > SQL Server Management Studio
3. Connect to the appropriate instance of the Microsoft SQL Server Database Engine, in Object Explorer; click the server name to expand the server tree.
[image: ]

4. Expand Databases
5. Right-click the database (if already exists), Tasks > Restore > Database…
[image: ]

6. On the General page, select From device: Click the browse button (ie …)
[image: ]
7. Now the Specify Backup dialog box is visible. Click Add
[image: ]

8. After you add the downloaded database to the list (extract if needed), click OK to return to the General page
[image: ]

After selecting screen should look similar to below screen shot, if so, click Ok:
[image: ]

9. In the Select the backup sets to restore grid, select the backups to restore by the check box beside it (this should only be one). This grid displays the backups available for the specified location.
[image: ]

10. Click Options in the Select a page pane
11. In the Restore options panel, you can choose any of the following options, if appropriate (for your situation and most other situations): Check Overwrite the existing database
[image: ]

12. Once Ok is clicked the Restore of the database will begin (ie: 0 to 100%)
[image: ]

13. Successful Restore of a database
[image: ]

14. Test for successful login to software to complete, please note that in most cases Osnium will set the Administrator password to ABC for login to the software for North Carolina.


[bookmark: _Toc402513218]Running Reports for North Carolina
Custom reports have been setup for North Carolina, the latest versions of the Reports or Guides can be found at http://documentation.osnium.com > WS > Reports
General Reports (used by all WS users)
http://documentation.osnium.com > WS > Reports > 0 – General
Custom Guides and Reports for North Carolina
http://documentation.osnium.com > WS > Reports > North Carolina 

Custom guides for North Carolina will require General Reports and Custom Reports. 


[bookmark: _Toc402513219]Using the Reporting guide with a General Report
An example of running a General Report (sometimes referred to a Master Report) for a specific Grant in North Carolina
Council for Women (SA and DV)
This page on the guide is asking for the Call Report, open the Call Report and modify the Reporting Date Ranges and numbered Parameters:
[image: ]


Opening the Call Report
[image: ]
Entering the Date Range
[image: ]


Entering requested Parameters
[image: ]
Click Submit to get the results (if data exists for the report).  If no results, the parameters might be incorrect or data in WS might not match, it would be best to clear some of the parameters to see where the results start.


Now that there are result, the Reporting Guide will provide detail on where to look with the report:
[image: ]
Repeat this similar process for all requested reporting for the agency.


[bookmark: _Toc402513220]Using the Reporting guide with a Custom Report
An example of running a General Report (sometimes referred to a Master Report) for a specific Grant in North Carolina
Council for Women (SA and DV)
This page on the guide is asking for the Administrative Time – Education-Training Report, locate and option the report entering the Reporting Date Ranges and any other Parameters requested:
[image: ]
Opening the custom report
[image: ]
Entering the Date Range and other Parameters
[image: ]
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